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Computer Science Syllabus for Class V 
 

 
 

Lesson Title/Topic of the lesson No. of Periods 

1. Computer Fundamentals 
 Block diagram of a computer 
 Computer Memory 
 I/O Devices 

 

7 

2. Computer Languages 
 Introduction 
 Types of Languages 
 Language processors 

 

6 

3. Networks 
 Introduction 
 Components of Network 
 Advantages 
 Types of Networks 

 

 
8 

4. HTML 
 Introduction 
 History of HTML 
 Uses of HTML 
 Structure of HTML 
 HTML Tags 
 Simple  HTML Programs 

 
 

 
8 

5. Power Point Presentation-Introduction 
 Introduction to PowerPoint 
 Uses of Power Point 
 Features of PowerPoint 
 File Menu commands 
 Creating Presentation with design theme 

 
 

7 

6. Power Point Presentation-Advanced 
 Formatting Presentations 
 Working with slides 
 Inserting graphics 
 Working with objects 
 Changing Views 
 Animation effects 

 
 

 
8 
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7. QBasic–Part-1 

 Introduction 
 Working with QBasic 

 Character Set 
 Constants 
 Variables 
 Operators 
 Expressions 

 
 
 

8 

8. QBasic–Part-2 
 QBasic Commands 
 PRINT,REM,CLS,INPUT,LET 
 Built-in Functions 
 IF statement 
 Simple Programs 

 
 

8 

Total Number of periods 60 
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Content  

Sl No Chapter  Page No 

1 Computer fundamentals 4 

2 Computer Languages 11 

3 Network  16 

4 HTML 21 

5 Power point presentation introduction 28 

6 Power point presentation advance 35 

7 QBASIC  part -1 51 

8 QBASIC part -2 55 
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Chapter 1 

COMPUTER FUNDAMENTALS 

Learning Objective: 

 Student will learn basic diagram of computer 

 Student will learn various input output and  peripheral 

devices  

 Basic of computer memory 

Basic components of Computer  

Input Unit 

The devices which are used to input the data and programs in the 

computer are known as "Input Devices". The input 

unit accepts instructions and data from the user 

and converts these instructions and data in 

computer acceptable format which are sent to 

computer system for processing. 
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Keyboard: Keyboard is most common input device. The data and 

instructions are input by typing on the keyboard. The message typed 

on the keyboard reaches the memory unit of a computer. It is 

connected to a computer via a cable. Apart from alphabet and numeral 

keys, it has other function keys for performing different functions.  

Mouse: It is a pointing device. The mouse is rolled over the mouse 

pad, which in turn controls the movement 

of the cursor in the screen. You can click, 

double click or drag the mouse. Its sensor 

notifies the speed of its movements to the 

computer, which in turn moves the 

cursor/pointer on the screen.  

Scanner: Scanners are used to enter information directly in to the 

computer memory. This device works like a 

Xerox machine. The scanner converts any type 

of printed or written information including 

photographs into digital pulses, which can be 

manipulated by the computer.  

Track Ball: Track ball is similar to the upside- down design of the 

mouse. The user moves the ball directly, while the 

device itself remains stationary. The user spins the ball 

in various directions to effect the screen movements.  

 

Light Pen: This is an input device which is 

used to draw lines or figures on a computer 

screen. It is touched to the CRT screen where it 

can detect raster on the screen as it passes. 
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Optical Character Reader (OCR): It is a device which detects 

alpha numeric characters printed 

or written on a paper. The text 

which is to be scanned is 

illuminated by a low frequency 

light source. The light is absorbed 

by the dark areas but reflected from the bright areas. The reflected 

light is received by the photocells. 

Bar Code Reader: This device reads bar codes 

and coverts them into electric pulses to be 

processed by a computer. A bar code is nothing but 

data coded in form of light and dark bars. 

Voice Input Systems: It converts spoken words to 

machine language form. A microphone is used to 

convert human speech into electric signals. The signal 

pattern is then transmitted to a computer when it is 

compared to a dictionary of patterns that have been 

previously placed in a storage unit of computer. When a close match is 

found, the word is recognized.  

Digital Camera: It converts graphics directly 

into digital form. An electronic chip in used in 

camera, when light falls, on the chip though the 

lens, it converts light waves into electrical waves. 

Output Unit  

Output Device produces the final results of computer into human 

understandable form. Output unit accepts the results produced by the 

computer which are in coded form and it converts these coded results 

to human readable form.  
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Monitor: The monitor looks like a television 

screen. It is also called Visual Display Unit 

(VDU) and it is used to display information 

from the computer. There are coloured as well 

as black and white monitors. The monitor 

displays text and graphics. Based on the 

technology used, monitor is classified into two types. They are 

Cathode Ray Tube (CRT) monitor and Liquid Crystal Display (LCD) 

monitor. 

Printer: A printer is used for transferring 

data from the computer to the paper. 

There are colour printers as well as black 

and white printers. The different types of 

printers are Dot Matrix Printers, Inkjet 

Printer and Laser Printers. 

Touch Screen: A touch screen is a display 

screen that is sensitive to human touch. It 

allows the user to interact with the computer 

by touching pictures or words displayed on the 

screen. Touch screens are used to display the 

output information on the screen as well as to 

give input by touching the words or pictures on the screen. Thus it is 

an input/output device. Touch screens are normally used when 

information has to be accessed with 

minimum effort. 

Plotter: Plotter is very large in size and is 

used to produce graphical output on papers. 

It uses single or multi-colour pens to draw 

pictures as blue print, posters etc 
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Storage Unit  

The data and instructions that are 

entered into the computer system through 

input units have to be stored inside the 

computer before the actual processing 

starts. Similarly, the results produced by 

the computer after processing must also 

be kept somewhere inside the computer 

system before being passed on to the output units. The Storage Unit 

or the primary / main storage of a computer system is designed to do 

all these things. It provides space for storing data and instructions, 

intermediate results and for the final results. 

Memory is primarily of three types 

 Cache Memory 

 Primary Memory or Main Memory 

 Secondary Memory 

Central Cache Memory: Cache memory is a very high-speed 

semiconductor memory which can speed up CPU. It acts as a buffer 

between the CPU and main memory. It is used to hold those parts of 

data and program which are most frequently used by Central 

Processing Unit (CPU)  

Primary Memory (Main Memory): Primary memory is also 

known as main memory. It holds only those data and instructions on 

which computer is currently working. It has limited capacity and data 

is lost when power is switched off. It is generally made up of 

semiconductor device. 

The main unit inside the computer is the CPU. This unit is responsible 

for all events. 

Primary memory can be divided into RAM (Random Access Memory) 

and ROM (Read Only Memory).  
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Secondary Memory 

It is also known as external memory or non-volatile memory. It is 

slower than main memory. These are used for storing data or 

information permanently. For example: hard disk, CD-ROM, DVD etc. 

Inside the computer. It consists of Control Unit and Arithmetic and 

Logic unit. The CPU is the brain of any computer system. In a human 

body, all major decisions are taken by the brain and the other parts of 

the body function as directed by the brain. Similarly, in a computer 

system, all major calculations and comparisons are made inside the 

CPU and it activates and controls the operations of other units like 

Hard disk, Printer etc. of a computer system. 

Arithmetic and Logic Unit (ALU): The arithmetic and logic unit 

(ALU) is the part where actual computations take place. It consists of 

circuits that perform arithmetic operations (e.g., addition, subtraction, 

multiplication, division over data received from memory and capable to 

compare numbers (less than, equal to, or greater than etc.). 

Control Unit: The control unit acts as a central nervous system for 

the components of the computer. It manages and coordinates the 

entire computer system. It obtains instructions from the program 

stored in main memory, interprets the instructions, and issues signals 

that cause other units of the system to execute them. The control unit 

directs and controls the activities of the internal and external devices. 
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Exercise 

I. Answer the following questions 

1. Draw the block diagram of a computer. 

2. List a few input devices. 

3. List a few output devices. 

II. Fill in the blanks. 

1. The _______________ is the part where actual computations take  

place. 

2. The control unit acts as a _____________ for the components of the  

Computer. 

3. Memory is primarily of three types________, ________ and __________. 

4. _____________ is a pointing device. 

5. __________ is similar to the upside- down design of the mouse. 
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Chapter 2 

Computer Language 

Learning Objective: 

 Student will learn about different type of computer programming 

language 

 Student will learn about various type of software  

A language is defined as the medium of expression of thoughts. All the 

human beings in this world communicate with each other by a 

language. Similarly, computer also needs some expression medium to 

communicate with each other’s. 

A computer follows the instructions given by the programmer to 

perform a specific job. To perform a particular task, programmer 

prepares a sequence of instructions, known as program. A program 

written for a computer is known as Software. 

 

 

 

 

 

1)First Generation Languages -1GLs (Machine language): 

When the human being stared programming, the computer the 

instructions were given to it in a language that it could easily 

understand is called as machine language. The binary language of 1 

and 0 is known as Machine language. Any instruction in this language 

is given in the form of 1s and 0s. 

2) Second Generation Languages- 2GLs (Assembly Language): 

The first language similar to English was developed in 1950 which was 
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known as Assembly Language or Symbolic Programming Languages. 

An assembly language is a low-level programming language for 

microprocessors (CPU) and other programmable devices. 

3)Third Generation Languages- (3GLs) (High Level Languages): 

The languages developed which were nearer to the English language in 

1960 were known as High Level languages. The different high-level 

languages are FORTRAN, COBOL, BASIC, PASCAL, PL-1 and many 

others. 

4) Fourth Generation Languages- (4GLs) (Query languages): 

The 3GLs are procedural in nature means HOW the problem get 

programmed and the procedures require the knowledge of HOW the 

problem will be solved. .4GLs are non-procedural that focuses on 

WHAT of the problem is coded means ‘WHAT is required’. The main 

aim of 4GLs is to be cut down on developed and maintenance time and 

making it easier for users. Example of 4GL is SQL (Structured Query 

Language). 

5) Fifth Generation Language-(5GLs): 

The 5GLs are designed to make the computer “Smarter”. The use of 

5GLs language touches on expert systems, computerized collection of 

the knowledge of many human experts, artificial intelligence and 

independently smart computer systems. Examples of 5GL are Prolog, 

OPS5 and Mercury. 

Graphical User Interface (GUI) based languages: These are the 

languages which use a Graphical User Interface to write, compile & 

execute the program with ease. Some of them are 

 Visual Basic  

 Visual C++  

 C# (Pronounced as C sharp)  

 Visual Basic.NET  
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 Visual Basic 2005 

Software: Computer software also called program is a set of 

instructions that directs a computer to perform specific tasks or 

operations. Computer software consists of computer programs and 

libraries. 

 

System software: Software that directly operates the computer 

hardware to provide basic functionality needed by users and other 

software and to provide a platform for running application software. 

System software includes: 

Operating system (OS): Operating system manages resources of 

computer system like memory, CPU, hard disk, printer etc. also 

provides an interface between user and computer system & provides 

various services to other software.  

Language Processor & Device drivers: All the devices like 

mouse, keyboard, modem etc needs at least one corresponding device 

driver. A device driver is a program that controls a device. A language 

processor is a hardware device designed or used to perform tasks, 

such as processing program code to machine code. Language 

processors are found in languages such as Fortran and COBOL . 

Application software: Software that performs special functions or 

provides entertainment functions beyond the basic operation of the 

computer itself. There are many different types of application software. 
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 General purpose: Microsoft Word, Microsoft Excel, MS 

PowerPoint, Photoshop etc. 

 Customized: Invoice Management System, Airline Reservation 

System etc. 

 Utilities: Antivirus, Memory tester, Disk partitioning and Disk 

defragmenter etc. 

 

Exercise 

I. Answer the following questions 

1. List the different generation of programming languages. 

2. What is a high-level language? Give examples. 

3. List types of application software. 

II. Fill in the blanks 

1. The binary language of 1 and 0 is known as __________. 

2. 4GLs are non-procedural that focuses on _______ of the 

problem. 

3. Operating system (OS): Operating system manages 

resources of ________. 
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Chapter 3 

Networks 

Learning Objective: 

 Student will learn about Network and type of Network 

What is a Computer Network? 

Computer Network is a group of computers connected with each other 

through wires, optical fibers or optical links so that A computer 

network allows computers to exchange data, Information and share 

resources. The connections between computers (nodes) are established 

using either cable media or wireless media. Various devices can 

interact with each other through a network. 

Components Of Computer Network: 

 
 
 
 
 
 
 
 

 

In the case of computer network technology, there are several types of 

networks that vary from simple to complex level. 

Advantages of Computer Networking 

 It enhances communication and availability of information.  

 It allows for more convenient resource sharing.  

 It makes file sharing easier.  

 It is highly flexible.  

 It is an inexpensive system.  

 It increases cost efficiency.  
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 It boosts storage capacity. 

Types of Networks: 

 

 

 

 

 

 

 

There are many types of computer networks, including the following: 

 Local-Area Network (LAN): The computers are connected in 

a building or office. 
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 Metropolitan-Area Network (MAN): A network designed 

for a town or city. 

 

 

 

 

 

 

 

 

 

 

 

 

 Wide-Area Network (WAN): The computers are connected by 

telephone lines or radio waves across country or continent. 
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 Personal Area Network (PAN): A network contained within 

a user's home that connects a person's digital devices. 

 

 

 

 

 

 

 

Internet 

 

 

 

 

 

 

 

Internet is a collection of computers connected by network cables or 

through satellite links. Internet is a network of networks. It is also 

known as Super Network. There are millions of computing devices that 

are connected to this network either permanently or for a short 

duration. These devices run network applications that communicate 

through copper or fiber optic cables, radio or satellite transmission. 
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Exercise 

I. Answer the following. 

1. Name the different types of networks. 

2. List the components of computer network. 

3. List any two advantages of computer networking. 

II. Fill in the blanks. 

1. Computer Network is a group of computers connected with each  

other through _____, __________ or ______. 

2. _________ is a collection of computers connected by network cables  

or through satellite links.  

3. ______________is also knows as Super Network. 
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Chapter 4 

HTML 

Learning Objective: 

 Student will learn about HTML and HTML file structure 

 Student will learn how to  create a simple webpage  

HTML is a computer language invented to allow website creation. The 

websites can then be viewed by anyone else connected to the Internet. 

It is relatively easy to learn, with the basics being accessible to most 

people in one sitting and quite powerful in what it allows you to create. 

HTML is used to build the websites or web-based applications. 

Tim Berners-Lee and Robert Caillau at CERN, in 1989-1990 developed 

HTML as a simplification of SGML. There are several different version 

of HTML – HTML 1.0, 2.0, 3.2, 4.0, 4.01 – 

XHTML 1.0 and 1.1 

HTML stands for Hyper Text Markup 

Language. 

• HyperText is the method by which you 

move around on the web by 

clicking on special text called 

hyperlinks which bring you 

to the next page. 

 

 

 

• Markup is what HTML tags do to the text inside them. They mark it 

as a certain type of text for example italicized text. 
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HTML consists of a series of short codes typed into a text-file called as 

tags. The text is then saved as html file, and viewed through a browser 

like Internet Explorer. This browser reads 

the file and translates the text into a visible form, hopefully rendering 

the page as the author had intended. 

Some of the most popular HTML editors, such as FrontPage or 

Dreamweaver will let you create pages more or less as you write 

documents in Word or whatever text editor you are using. 

Uses of HTML 

 HTML is mainly used to design webpages. 
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A Webpage 

 

 It is also used to navigating the internet. 

 HTML also allows you to not only embed images into a webpage.  

 

Structure of an HTML  

HTML tags are like keywords which defines that how web browser will 

format and display the content. 

 

 

 

 

 

 

 

 

 

 

There are four sets of HTML tags that form the basic structure needed 

for every HTML file: 

• <html></html> 

This basically defines the document as web page. It also identifies the 

beginning and end of the HTML document. All other tags must fall 

between the html tags. 
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• <head></head> 

The header contains information about the document that will not 

appear on the actual page, such as the title of the document, the 

author etc. 

• <title></title> 

The title tag defines the title that will appear in the title bar of your 

web browser. The title must appear between the head tags. 

• <body></body> 

The body tags contain all the information and other visible content on 

the page. All your images, links and plain text must go between the 

<body> and </body> tags. 

You may also be interested in the basic tags for adding content and 

headings. 

Example: 

Below is a basic html document. Notice that everything falls between 

the html tags, the title appears within the head of the document, and 

that the body comes after the head. 

1. Open Notepad. 

2. Type the HTML program as given below. 

 

 

3. Click file->Save as 
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4. Select Desktop, type the file name as myfile.html and select All files 

in Save as type box and click on 

save. Your HTML file will be saved 

to desktop. 

5. Double click on the file (as 

shown below) and your webpage 

is ready for display. 

 

 

Empty tag and Container tag 

A container tag has two ends (an opening and a closing) whereas an 

empty tag doesn't. 

The paragraph tag is an example of a container tag: 

<p>Our paragraph text here.</p> 

The image tag is a good example of an empty tag. 

<img src="aeeslogo.png" > 
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See how the initial paragraph tag (<p>) has a corresponding end tag? 

The text in between is "contained" by the tag. 

The majority of tags are "container" tags. They have an opening and a 

closing tag. 

However, a few tags are "self-contained" or "empty" tags in that they 

have an opening tag but not a closing one. 

They common ones are: 

• <br> = break 

• <img> = image 

• <meta> = metadata within an HTML document. 
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Exercise 

I. Fill in the blanks 

1. Extension of a HTML file is…………………… 

2. Predefined command in HTML is knows as………………… 

3. HTML is a ………………………language. 

4. All HTML programs must have………………tag the begging of 

program. 

5. The ………………contains information about the document that will 

not appear on the actual page. 

6. The ………… tag must appear between the head tags. 

7. The ……………tags contain all the information and other visible 

content on the page. 

8. A ……….……………tag has an opening and a closing end. 

9. A…………………tag doesn't have a closing end. 

10....................is an example empty tag. 

II. Create a HTML page that contains your name, class, father’s name, 

mother’s name etc. Save this HTML file to Desktop and test the result. 
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Chapter 5 

 

Power Point Presentation-Introduction 

Learning Objective: 

 Student will learn about Power Point presentation 

 Student will learn slide design and animation in Power point  

 Introduction to Power Point 

 Power Point Presentation is an electronic slide show program 

that uses graphics, videos, etc. to make a presentation more 

interactive and interesting. We can create presentations using 

this program. 

 A Power Point presentation comprising slides and other features 

is also known as PPT. 

 The file extension of a saved Power Point presentation is “.ppt”. 

 

 

 P 

 

 

 

 

 

 

 

 Uses of Power Point 

1. Power Point in Education  

Teachers can use PowerPoint to teach subjects lessons and chapters 

of any book. They can create or delegate to produce a complete 
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presentation of a book. It gives the opportunity to the teacher to cover 

a topic in the different t slides.   

 

2. Power Point in Business  

Business is all about creating a plan, marketing strategies, execution, 

and making methods to follow and integrate. PowerPoint helps people 

in business to create a plan, structure related to the business or 

organization.   

 

3. Power Point for Housewives  

Housewives can easily invest their time in learning PowerPoint 

presentations. They can create slide shows in which they can generate 

numbers, calculations, alphabets, or all kinds of lessons they want to 

teach their kids in slideshows.   

 

4. Power Point in Governance and Citizen Services  

PowerPoint documents can be printed so whenever the citizen visits 

any government sector they can easily find or access government 

services through the file or document.  

 

5. Power Point for Job Seekers  

Through PowerPoint, job seekers can create digital resumes or 

multimedia resumes and it will become a unique way of presenting 

skills and knowledge in front of interviewers. 

 

 Features of Power Point 

There are multiple features that are available in MS PowerPoint which 

can customise and optimise a presentation. The same have been 

discussed below. 

 Slide Layout 
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Multiple options and layouts are available based on which a 

presentation can be created. This option is available under the “Home” 

section and one can select from the multiple layout options provided. 

The image below shows the different slide layout options which are 

available for use: 

 

 Insert – Clipart, Video, Audio, etc. 

Under the “Insert” category, multiple options are available where one 

can choose what feature they want to insert in their presentation. This 

may include images, audio, video, header, footer, symbols, shapes, 

etc.  

The image below shows the features which can be inserted: 

 

 Slide Design 

MS PowerPoint has various themes using which background colour 

and designs or textures can be added to a slide. This makes the 

presentation more colourful and attracts the attention of the people 

looking at it. 
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This feature can be added using the “Design” category mentioned on 

the homepage of MS PowerPoint. Although there are existing design 

templates available, in case someone wants to add some new texture 

or colour, the option to customise the design is also available. Apart 

from this, slide designs can also be downloaded online. 

Refer to the below for slide design: 

 

 

 

 

 

 

 

 Animations 

During the slide show, the slides appear on the screen one after the 

other. In case, one wants to add some animations to the way in which 

a slide presents itself, they can refer to the “Animations” category.  

The different animation styles available on PowerPoint are: 

 

 

Apart from all these options; font size, font style, font colour, word art, 

date and time, etc. can also be added to a PPT. 

 File Menu commands 

The File Menu:  

At one end of the ribbon is the File tab, which you use for the behind-

the-scenes stuff you do with a file, such as opening, saving, sharing, 
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exporting, printing and managing your presentation. Click the File tab 

to open a new view called the Backstage. 

The options under the File menu are Info, Open, New, Save, Save As, 

Print, Share, Export, Close, Account and Options. 

 

Click from the list on the side to do what you want to do; for example, 

click Print to find the options and settings for printing your 

presentation. Click Back  to return to the presentation that you 

were working on. 

 Creating Presentation with design theme 

A theme is a design scheme of colours, fonts, and background that 

you apply to your slides. 

 

Using a theme gives your presentation a pleasant appearance with 

minimal effort. Text and graphics automatically take on the size, 

colours, and placement defined by the theme, which means less 

manual work as you create individual slides. 
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After you create a theme, it's located on the Design tab in the Themes 

gallery. To try out a theme, rest your mouse pointer over a thumbnail 

in the Themes gallery and notice how the look of your slide changes. 

 

 

 

 

 

 

 

 

 

 

 To choose a theme for your presentation 

PowerPoint offers several preset themes. They are on the Design tab of 

the Ribbon on the left side. 

1. Open a slide. On the Design tab, point at a Theme thumbnail 

to get a preview of how it would affect the look of your slide. 

2. To see the full gallery of themes, click the More button: 
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Test Your Knowledge 

 

I. Choose the correct answer 

1. _____ is a presentation program. 

(A) U-torrent 

(B) Mozilla Firefox 

(C) MS PowerPoint 

(D) Slide Panel 

 

2. The file extension of a saved Power Point presentation is _____ 

(A) .docx 

(B) .ppt 

(C) .xlsx 

(D) .accdb 

 

3. Print option is visible in ______ menu. 

(A) Insert 

(B) View 

(C) Home 

(D) File 

 

4. A _____ is a design scheme of colours, fonts, and background that 

you apply to your slides. 

(A) insert 

(B) theme 

(C) view 

(D) review 

 

II. What are the uses of a Power Point Presentation? 
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Chapter 6 

Power Point Presentation-Advanced 

Learning Objective: 

 Create and manipulate simple slide with various formatting.  

 Create slide presentations that include text, graphics, animation  

 Learning various effect in animation of  slide show 

 Formatting Presentations 

 

Formatting the Text 

 Open your presentation in PowerPoint. 

 Select the text you want to modify. 

 On the Home tab, in the Font group, you’ll find a lot of 

buttons and settings that you can use to customize and 

modify the text. This group contains everything related to the 

font and its styles. 

 To change the font of a text, select it and click the Font drop-

down arrow. You’ll see a list of available fonts. 

 Click the one you want to apply. The text will change 

accordingly. 

 

 

 

 

 

 

 

 

 To change the size of your text, select it, click the Font Size drop-

down arrow and choose the desired value. 
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 Next, we have the Bold, Italic and Underline buttons.  

 Boldis used for emphasis.  

 Italic makes your text lean slightly to the right.  

 Underline draws a line under your text, in case you want to 

highlight something.  

 To apply any of these styles, select the text and click the 

corresponding button. 
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 Next, we have the Text Highlight Colour and Font Colour 

buttons. 

 As their names suggest, the first one determines the Colour of 

the highlight and the second one determines the Colour of the 

text itself.  

 It’s easy to change any of them: select the text, click the arrow 

next to Text Highlight Colour or Font Colour and choose the   

desired Colour from the list. 
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 Aligning the Text 

 Once you’ve entered your text, you might want to align it 

properly so that it looks nice on the screen. 

 The options found in the Paragraph group will help you. There 

are two types of alignment: 

 If you click the Left Align, Centre Align or Right Align buttons, 

you’ll align the text to the left, centre or right, respectively. 

 The last button, Justify, aligns the text so that each line has the 

exact same length. 
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 Working with slides 

Add slides 

 Select the slide you want your new slide to follow. 

 Select Home > New Slide. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Select a layout. 

 

 

 

 

 

 

 

 

 

 

 Select the text box and type. 
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Delete slides 

 For a single slide: Right-click the slide in the thumbnail pane on 

the left, and select Delete Slide. 

 For multiple slides: Press and hold Ctrl, and in the thumbnail 

pane on the left, 

select the slides. 

Release the Ctrl key. 

Then right-click the 

selection and choose 

Delete Slide. 

 For a sequence of 

slides: Press and hold 

Shift, and in the thumbnail pane on the left, select the first and 

last slides in the sequence. Release the Shift key. Then right-

click the selection and choose Delete Slide. 

Duplicate a slide 

 In the thumbnail pane on the left, right-click the slide thumbnail 

that you want to duplicate, and then click Duplicate Slide.  

 The duplicate is inserted immediately after the original. 
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Rearrange the order of slides 

 In the pane on the left, click the thumbnail of the slide that you 

want to move, and then drag it to the new location. 

 To select multiple slides: Press and hold Ctrl, and in the pane on 

the left, click each slide that you want to move. Release the Ctrl 

key, and then drag the selected slides as a group to the new 

location. 

 

 

 

 

 

 

 

 

Inserting graphics 

Insert a picture in PowerPoint 

Insert a picture from your computer on your slide 

Depending on which version of PowerPoint you're using, you can 

insert pictures, photos, clip art, or other images to your slide show 

from your computer or from the Internet. 

 Click where you want to insert the 
picture on the slide. 

 On the Insert tab, in the Images group, 
click Pictures and then click This 
Device. 

 

 

 

 

 

 In the dialog box that opens, browse to the picture that you 

want to insert, click that picture, and then click Insert. 
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Insert stock images on your slide 

 Click where you want to insert the picture on 

the slide. 

 On the Insert tab, in the Images group, 

click Pictures and then click Stock Images. 

 Type in what image you're looking for, then 

click on which images you want and 

click Insert. 

 

Insert a picture from the web on your slide 

 Click where you want to insert the picture on the slide. 

 On the Insert tab, in the Images group, click Pictures and 

then click Online Pictures. 

 

 

 

 

 

 

 

 

 In the search box type in the image, you're looking for and press 

enter.  

 Select all the images you want and then click Insert. 

 

 Working with Objects 

Objects: Objects are any element that you can add in PowerPoint. A  

text label is an object. An image is an object. Graphs and charts are 

objects. Any element within a slideshow is an object. 
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Inserting a picture in PowerPoint: 

We can insert pictures, photos, clip art, or other images to your slide 

show from your computer or from the Internet. 

 Click where you want to insert the picture on the slide. 

 On the Insert tab, in the Images group, click Pictures and then 

click This Device. 

 

 

 In the dialog box that opens, browse to 

the picture that you want to insert, click 

that picture, and then click Insert. 

 

 

Insertstock images on your slide: 

 Click where you want to insert the picture on the slide. 

 On the Insert tab, in the Images group, click Pictures and then 

click Stock Images. 

 

 

 

 

 

 

 

 

 Type in what image you're looking for, then click on which 

images you want and click Insert. 
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Insert a picture from the web on your slide: 

 Click where you want to insert the picture 

on the slide. 

 On the Insert tab, in the Images group, 

click Pictures and then click Online 

Pictures. 

 In the search box type in the image, you're 

looking for and press enter.  

 Select all the images you want and then 

click Insert. 

In this way you can also insert charts and graphs into slides. 

 

 Changing views 

 To change views, find the View button on PowerPoint's ribbon 

and click on it. 

 Then you can see Normal, Outline, Slide sorter, Notes page and 

reading views on the left side of the ribbon.  

 Normal Viewis typically the default view for working in Microsoft 

PowerPoint. 
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The Outline Viewin PowerPoint shows your presentation in a 

traditional, easy-to-read outline. This view puts your main points in 

the sidebar. 

 

  

 

 

 

 

 

 

 

 

 Slide Sorter Viewis a helpful way to re-order the slides in your 

PowerPoint presentation. 

 When you switch to Slide Sorter View, all your slides will be 

represented as thumbnails on the stage. 

 

 

 

 

 

 

Notes page view 

 Notes pages include your notes and each slide in the 

presentation. Each slide prints on its own notes page. Your notes 
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accompany the slide. You can add data, such as charts or 

pictures, to your notes pages. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Reading view 

 It displays the presentation in a full screen like Slide Show view, 

and it includes a few simple controls to make it easy to flip 

through the slides. 
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 Animation effects 

You can use animation to effectively manage the flow of information in 

your presentation, emphasise key points and to increase participants’ 

interest in your presentation. There are four types of animation effects 

in PowerPoint – entrance, emphasis, exit and motion paths. These 

reflect the point at which you want the animation to occur.  

 

 

 

 

 

 

 

 

 

Types Of Effects 

Many of PowerPoint’s animation effects are listed in the 

Animationsgallery. Each effect has an icon that indicates the way the 

effect works. The effects are grouped into the following four groups. 

Entrance: Entrance effects control the way objects appear on your 

slide.   For example, you may have individual lines of text fly in from 

the side of the slide, or have the slide titles gradually fading in as the 

slides display. 
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Emphasis: Emphasis effects control how 

the audience’s eye is drawn to the 

animated object. For example, you may 

make an image pulse or spin or have a 

line of text move in a wave shape. 

 

  

Exit: Exit effects determine how the 

animated objects will leave theslide. For 

example, an image may bounce or 

shrink and turn off a          slide. 

 

 

Motion Paths:Motion paths control the 

movement of your text or objects 

around the slide. For example, you 

could make objects move up and down, 

move in a specific shape or even create 

your own custom path for an object to   

follow. 

 

 

 

 

 

ANIMATING OBJECTS 

As well as animating text, you can apply animation to objects either to 

emphasise a concept or just to grab the audience’s attention. 
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Test Your Knowledge 

 

I. Choose the correct answer 

1. _______ is used for emphasis. 

(A) Bold 

(B) Italic 

(C) Underline 

2. ________ makes your text lean slightly to the right. 

(A) Bold 

(B) Italic 

(C) Underline 

3. ________ draws a line under your text, in case you want to highlight    

something. 

(A) Bold 

(B) Italic 

(C) Underline 

4. _______ button aligns the text so that each line has the exact same    

length. 

(A) Align left 

(B) Align right 

(C) Centre 

(D) Justify 

5. _________ is the default view for working in Microsoft PowerPoint. 

(A) Normal view 

(B) Outline view 

(C) Reading view 

6. __________ are any element that you can add in PowerPoint. 

(A) Slides 

(B) Objects 

(C) Buttons 

 

II. How many effects of animation in PowerPoint are there?  

Name them. 
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Chapter 7 

QBasic-part 1 

Learning Objective: 

 Student will learn about QBASIC  programming language 

 Student will learn  about constant and variable in QBASIC   

The name QBasic is an acronym for Quick Beginners All Purpose 

Symbolic Instruction Code. It was developed and launched by 

Microsoft in the year 1991 and is considered to be one of the most 

ideal languages for absolute beginners. It was intended as a 

replacement for GW-BASIC. QBasic was based on earlier QuickBasic 

4.5 compiler. It does not produce .exe files but instead generates files 

with extension .bas which can only be executed immediately by the 

built in QBasic interpreter. It is based on DOS operating systems but 

is also executable on windows. 

QBasic consists of two windows: 

Program Window:The window titled as ‘Untitled’ is the program 

window. It is the place where program/code is written 

 

 

 

 

 

 

 

 

 

 

Immediate Window:The window below Program Window titled as 

‘Immediate’ is the immediate window. This window is used as a 

debugging tool and is used when the user wants to check the output 

of a single statement. 
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Getting to QBasic 

To run QBASIC we need to get to the QBasic editor. 

Click on START (Located on the bottom 

left of your screen) – Click on ALL 

PROGRAMS – click on:  

Shortcut to microsoft quick basic. 

To construct the QBASIC program, we 

have to arrange some standard 

elements. The elements used in Qbasic 

are as follows: 

• Character set 

• Variables 

• Constants 

• Operator and Operands 

• Expression 

• Statements 

Character Set: QBASIC has the character set consisting of the 

following elements: Alphabets: A, B, C,....Z, Digits: 0, 1, 2........,9 and 

Special characters: + - * / ( ) . , $ ; ,: ,= ,> ,< , ^ ( The symbol ^ (caret) 

is used to denote exponentiation operator, the symbol * (asterisk) is 

used to denote multiplication and other symbols; have their usual 

meanings.) 

  Constants: A quantity in a computer program which does not change 

its value during the execution of the program is called a constant. 

QBASIC allows the following constants: 

Numeric constant: 

The numeric constant is one that is formed by a sequence of digits 0, 

1, 2,.....9 and may include a decimal point. A numeric constant may 

be an integer or a real number. 383, +57, 0, -6.2 and 6.15E4 are valid 

numeric constants.  

The number 6.15E4, in fact, represent 6.15 * 104. The notation E is 

used to represent the exponential form. The number after E is the 
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exponent which can be positive or negative. However, its length cannot 

exceed two digits. 

It is also important to keep in mind that: 

QBASIC does not distinguish between an integer and fraction. 

Commands are not allowed in a numeric constant. 

The limit on the number of digits that can be used varies from 

computer to computer. Normally, a numeric constant can have up to a 

maximum of eight digits. 

String constant:A string constant consists of a sequence of 

characters which must be enclosed by a quotation mark. 

Variables: The quantity which may change its values during the 

execution of the program is called the variable. 

In QBASIC, variables are also of two types: 

Numeric variable: Numeric variable can assume numeric value and is 

represented by an alphabet or an alphabet followed by another 

alphabet or digit. For example A, C, A2, ABC, A6 etc, represent 

numeric variables. 

String variable: A string variable is represented by an alphabet 

followed by dollar ()sign.It should be kept inmind that while 

constructing the string variable,  dollar() should be the last character. 

For example, B1,NAME,  BOOK1$, etc are valid string variables. 

Expression 

An expression can be a string, or numeric constant, a variable or a 

combination of constants, variables with operators which returns a 

single value. 

Operands 

Operands are the data or variables on which mathematical, logical and 

string operations take place. 

Operators: Operators are the symbols, which are used in arithmetic 

operations, logical expressions, and string expressions. 

Statements: A statement is a set of instructions written using 

keywords or commands of QBASIC. Every programming language uses 

keywords as a statement with certain syntax. 
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Exercise 

1. Define:   

a) Operands  

b) Statements  

c) String variable    

d) Numeric constant 

2. List the elements of the character set. 
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Chapter 8 

QBasic-part 2 

Learning Objective: 

 Student will learn about  writing basic of QBASIC program 

 Student will learn built in function in QBASIC program 

Some Basic useful commands on QBasic: 

1. PRINT: This command prints the statement or data written after it. 

If the data to be printed is a string, then it is written inside double 

quotes (” “) and if it is a number or a variable it can be written directly. 

  

 

2. INPUT: INPUT command is used to take inputs/data from the user. 

It can be used to input both strings and numbers. If the data to be 

taken is a numerical value, then the variable name in which it is to be 

stored is written directly after the INPUT command. 

  

3. CLS: CLS stands for Clear Screen and is used to clear the screen if 

some previous results/outputs are present on the screen. 

4. LET statement: It is used to assign the value of expression to 

variable. See assignment statements for more information about 

assigning values to variables. 

Ex LET A=5 

LET NAME$=”AEES” 

LET COUNTRY$=”INDIA” 

LENGTH =5 

BREADTH=15 

AREA = LENGTH* BREADTH 

PRINT “AREA =” AREA 

 

AREA =75 
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BUILD-IN OR LIBRARY FUNCTIONS:  

The functions which are provided by the QBASIC system and also 

allow the programmer to use them according to the requirement are 

known as BUILT-IN or Library Functions. These functions are required 

to be called by the programmer to use them in a program. Some 

common Build-IN or Library Functions are LEN, LEFT$, RIGHT$, 

MID$. Here are the types of library functions: 

Mathematical Functions 

The numerical data is processed using mathematical functions. The 

following are some of the mathematical functions used in QBASIC: 

SQR Function 

The SQR Function gives the result as the square root of the given 

number. 

Syntax: SQR (number) 

EX SQR(25) 

Ans:   5 

ABS Function 

This function is used to return the absolute value of a number or we 

can convert negative numbers into positive. 

syntax: ABS(number) 

ABS(-6) 

Ans: 6 

String Function 

The string functions are used to process string data. Here are some of 

the string functions used in QBASIC: 

–        LEN Function 

This function gives output as the length of a given string. 

Syntax: LEN (string) 

LEN(“aees”) 

Ans: 4 

LEFT$ 

This function retrieves the specified number of characters from the 

string’s left side. 
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Syntax: LEFT$ (string, n) 

LEFT$ (“aees”, 2) 

Ans: ae 

RIGHT$ 

This function retrieves the specified number of characters from the 

string’s right Side. 

Syntax: RIGHT$ (string, n) 

RIGHT$ (“aees”, 2) 

Ans:   es 

The IF statement always asks a question (usually about the number in 

a variable.) 

If the answer is TRUE the true branch is executed. 

If the answer if FALSE the true branch is skipped. 

In both cases, execution continues with the statement after the END 

IF. 

Here is the program  

PRINT "Enter 1 if you are hungry; 0 if you are not" 

INPUT HUNGER 

IF HUNGER > 0 THEN 

PRINT "Buy Cookies"     

END IF 

PRINT "Keep Shopping"      

END 
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Exercise 

Answer the following questions 

1. Write a program to add two numbers 

2. Write a program to multiply two numbers 

3. Write a program to print your name 

 

 


